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About this Guide 
The California Workforce Development Board’s (CWDB) Research Unit has compiled this guide 
for all grantees to better understand the data reporting requirements for all grant programs. 
The guide contains relevant information for all participant-serving projects funded by CWDB 
grant programs, important reporting deadlines and general expectations.1   
 
This is to help ensure that managing participant data in preparation for submission to the CWDB 
is as thorough and seamless as possible, with minimal burden. Ultimately, the CWDB wants 
grantees’ data management efforts to reflect the great work and impact the grantee’s program 
has on the workforce.  
 
This guide supports grantees’ efforts to collect and tracks participant data throughout the grant 
life cycle to ensure accurate information is reported about participants. It includes best 
practices for successfully developing effective data collection and tracking processes and 
incorporating them into the grant implementation. 
  

 
1 Please note that this guide does not constitute legal advice and grantees are encouraged to consult with legal 
counsel for individualized guidance. 
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Data Collection Tips 
Successful grant reporting doesn’t just happen. Before grantees can successfully report on a 
grant to CWDB, certain required information must be successfully tracked and collected. Doing 
this takes careful planning and forethought.  
 
Often, grantees realize that there were missed opportunities to capture needed information or 
realize that so many moving pieces couldn’t be shared accurately and on time. Even though the 
grantee’s programs may be performing well, those successes are not reflected in the data.  
Grantees then must spend a lot of time tracking down information or training partners and staff 
on brand-new policies, which could have been avoided with better data management protocols 
in place.  
 
The best time to start thinking about participant reporting is before grantees enroll any 
participants. Procedures should be established ahead of time to allow grantees to collect the 
information from participants and continue tracking them throughout the grant program and 
beyond.  
 
Below are some suggested steps that grantees can use during the grant start-up phase. These 
steps will help set the grant up to successfully collect and track participant information in 
accordance with grantee’s contract with CWDB: 

• Understand the reporting requirements and deadlines.  
• Understand funding streams.  
• Understand what information to collect and why.  
• Understand the timing of when information should be collected. 
• Develop an internal case management system. 
• Establish intake procedures that build-in participant data collection. 
• Establish a schedule to check-in with participants regularly. 
• Establish processes and methods to follow-up with participants after they leave the 

program. 
• Establish a process for regularly collecting information from grant partners. 
• Develop policies for documenting, validating, and securing data. 
• Understand technical assistance resources. 

 
This guide contains a toolkit of strategies and tips to help implement each of these steps. If 
participants have already started enrolling in a particular program(s), these tips can be used to 
develop new procedures and refine the ones that are currently in place to continue improving 
data collection and tracking processes. 

Understanding Reporting Requirements and Deadlines 
Grantees must report various types of data about projects and the participants they serve. 
Different types of data grantees are contractually obligated to report to CWDB including 
participant data, narrative reports, and occasionally supplemental reports. There are different 
deadlines for reporting data depending on the type of data. Many grant programs require data 
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to be reported both monthly and semi-annually. Refer to the data types outlined below and 
follow the appropriate reporting schedule.  
 
Grantees are contractually obligated to ask all participants for their Social Security Numbers 
(SSNs), and to report participants’ SSNs gathered and outcomes to CWDB. It is important to 
note that, while grantees are required to request participants’ SSNs, participants cannot be 
denied services if they choose not to disclose their SSN. The same is true of all participant 
demographic data collected in Cal-E-Grants for grant reporting purposes. Grantees must ask 
participants questions about identifying information in all fields CWDB provides to them. 
However, opting out of answering is always an acceptable answer. Grantees must report all 
information gathered about participants to CWDB, including any “opt out” answers. 
 

Participant Data 
Participant data is arguably the most critical type of data that grantees will collect and report to 
the CWDB. This data can indicate the overall success of grant programs and is used to inform 
future workforce funding. Participant data is collected in either California’s Job Openings 
Browse System (CalJOBS) or Cal-E-Grants, depending on the grant program. As a best practice, 
participant data should be entered as soon as it is gathered. CWDB will review participant data 
every month. If grantees have not input all collected participant data for a particular month by 
the 20th of the following month, they are in breach of the grant agreement, including risk of de-
obligation and ineligiblility for future funding. Refer to the Reporting Schedule tables in the 
following section for relevant deadlines.  
  

Narrative Reports 
Narrative reports provide overall project status updates in a narrative format. Narrative reports 
are due on a semi-annual basis and submitted in Cal-E-Grants. The templates for narrative 
reports are typically made available in Cal-E-Grants 1-2 months before the submission deadline 
and are in an open-ended question format, allowing for narrative answers. Grantees must 
submit timely narrative reports or risk being in breach of the grant agreement. 
  

Quarterly Check-In Meetings 
Check-ins are virtual meetings that allow grantees to report project successes, challenges, and 
overall project progress. These meetings are scheduled quarterly for the first year of the grant 
term. After the first year, the Program Branch will conduct a formal analysis to see if recurring 
quarterly meetings will continue or discontinue (if discontinuing, meetings will be scheduled as 
needed and not necessarily on a recurring, quarterly basis). Note that there will always be a 
formal meeting at the halfway point of the grant (known as the “Interim Analysis”) to discuss 
project deliverables.  
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Reporting Schedules 
Monthly Participant Data Reporting Schedule 

Reporting Period Reporting Deadline 

January 1 – January 31 February 20 

February 1 – February 28 March 20 

March 1 – March 31 April 20 

April 1 – April 30 May 20 

May 1 – May 31 June 20 

June 1 – June 30 July 20 

July 1 – July 31 August 20 

August 1 – August 31 September 20 

September 1 – September 30 October 20 

October 1 – October 31 November 20 

November 1 – November 30 December 20 

December 1 – December 31 January 20 
 

Semi-Annual Narrative Reporting Schedule 
Semi-Annual Period Reporting Deadline 

January 1 – June 30 July 20 

July 1 – December 31 January 20 
 

Understanding Funding Streams 
Understanding differences in funding streams of grant programs helps make sense of the 
differences in reporting requirements. Grant programs funded by the Workforce Innovation and 
Opportunity Act (WIOA) are mandated through federal legislation to collect participant data in 
CalJOBS. However, grantees for state-funded, non-WIOA programs are required to report 
participant data in Cal-E-Grants. The CalJOBS platform is managed by the Employment 
Development Department (EDD) and was specifically built for WIOA programs. The CWDB uses 
the Cal-E-Grants platform for participant data collection for these programs because state-
funded grant programs offer more flexibility and less stringent requirements. The CWDB has the 
authority to make changes within Cal-E-Grants, and using this platform for state-funded 
programs streamlines overall grant management for both CWDB and grantees. 
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Understand What Information to Collect and Why 
Why Participant Data? 
By law, the CWDB is charged with continuously improving California’s workforce system, and in 
doing so, asks questions like:  

• How can workforce development better reach historically marginalized populations? 
• How do grantees keep participants from dropping off the radar?  
• Which types of services have the greatest impact on participants’ employment and 

wages? 
 
To answer these questions, the CWDB needs data. For instance, the CWDB must know who is 
being served, what backgrounds participants have, how participants are being served, what 
services were provided, and how program services affected participant outcomes. This is why 
the CWDB collects data —to ensure continuous and equitable improvement of the California 
workforce system. 

Collecting sensitive information 
Some data collection topics are sensitive, which may affect the strategies used for accurate 
reporting. Examples of sensitive topics include: 

• Social Security Number (SSN) 
• Income 
• Race/Ethnicity 
• Gender identity 
• Sexual orientation  

Low response rates  
Not receiving enough data or information about participants being served by CWDB grant 
programs has various implications. It limits CWDB’s ability to determine:  

• The efficacy of programming.  
• If the CWDB is reaching focus populations. 
• How target populations are being served. 
• Where best to allocate future funding. 

Some potential outcomes of asking sensitive questions 
There are at least three primary outcomes of asking sensitive questions, all of which can affect 
the quality of data:  

• Participants refuse to provide the information and decide not to participate in the 
program once sensitive questions are asked. 

• Participants agree to provide information but leave some information blank. 
• Participants provide inaccurate responses or under-report information.  

When to ask questions 
It’s not always clear how respondents will respond to sensitive questions. For the CWDB to 
accurately determine if and how programs serve communities across California, grantees must 
have data on the participant’s workforce funding services. In some instances, this means 
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collecting sensitive information that may be uncomfortable for participants and staff to discuss 
openly.  

How to collect better data when asking sensitive questions 
Some suggestions:  

• Include a self-administered survey or application as part of the intake process. 
Creating a self-administered survey as part of the intake process, when possible, 
increases the chances that participants will provide sensitive information. This could be 
completed in private and may feel less intrusive.  
 

• Assure confidentiality. 
Describe what steps are being taken to ensure the data collected is protected. How will 
the information be used, and who will have access to it? Systems for securing sensitive 
information should be in place by the grantee before any sensitive information is 
collected, so it can be stored correctly.   
 

• Explain why information is being collected verbally and in writing. 
Adequately explain why participants are being asked for this information (and how it will 
be used). For example, before asking for detailed demographic information, grantees 
might first explain, “We ask about income and housing insecurity to understand the 
types of supportive services that you might benefit from to be successful in this 
program.” Refer to the Sample Disclaimer section in this document for examples of 
potential disclaimers related to the collection of sensitive information.2  

 
• Put demographic questions at the end of the intake process. 

Sharing personal and sensitive details when beginning a new training program can make 
respondents feel uncomfortable due to past experiences or challenges accessing 
programs or services. For some questions, respondents may also feel shame or 
discomfort sharing information due to past experiences. This may make people more 
reluctant to answer sensitive questions honestly. It is better to save demographic 
questions for the end. 
 

• Present sensitive questions toward the end of the intake process (but not the very end). 
When an information gathering session begins with sensitive questions, this can feel 
jarring and intrusive for some training participants. Build trust by asking fewer sensitive 
questions upfront. Once grantees have built rapport and trust, then ask sensitive 
questions. These questions should be part of an ongoing case management strategy to 
allow for the gradual collection of participant information as trust develops.  
 

 
2 CWDB cannot provide legal advice or assurances that the sample disclaimers are currently compliant with all 
applicable laws. Grantees may consider consulting with legal counsel to ensure it is complying with all notice 
requirements. 
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Personal Information Notice 
Effective Date: 9/12/2023 
 
The California Workforce Development Board (CWDB) administers its programs as authorized by 
current legislation. It collects Personal Information (as defined in CWDB’s Privacy Policy), 
including name, social security number, birth date, and address.  
 
Providing this information is mandatory. Without it, the CWDB cannot effectively complete 
program evaluation and participant eligibility effectively. The CWDB collects Personal 
Information for the purpose of:  

• Program Evaluation  
• Participant Eligibility 

 
Any organization that submits Personal Information to CWDB or its service providers represents 
and warrants that:  

• They have the authority to disclose the information and use the information in 
accordance with this Notice of Collection, and  

• The information is accurate. 
 
Participant data collected by the CWDB includes information in the following general categories:  

• Individual demographics: Such as name, birth date, racial or ethnic group, disability, 
employment status, social security number, and address. 

• Training services: Dates and types of training services that participants receive while in 
the program, including apprenticeships and service providers. 

• Career services: Dates and types of career services that participants receive while in the 
program, including work experience and service providers. 

• Supportive services: Dates and types of supportive services that participants receive 
while in the program, including stipends and service providers. 

• Credentials: Credentials received, including industry-recognized certificates resulting 
from the training provided in the program. 

• Outcomes: Information related to post-exit from the grant program, including training 
and employment. 

 
Definitions for the variables collected in both CalJOBS can be found in the Participant Individual 
Record Layout (PIRL). Definitions for variables collected in Cal-E-Grants can be found in the Data 
Fields Guide. 
 

Collecting Social Security Numbers  
The Office of Management and Budget (OMB) defines Personally Identifiable Information (PII) 
as information that can be used to distinguish or trace an individual’s identity, either alone or 
when combined with other personal or identifying information that is linked or linkable to a 
specific individual. Grantees should ensure that when collecting this information from 

https://cwdb.ca.gov/privacy-policy/
https://www.dol.gov/sites/dolgov/files/ETA/Performance/pdfs/ETA_9172_DOL_PIRL_Non-Material-Change.pdf
https://www.dol.gov/sites/dolgov/files/ETA/Performance/pdfs/ETA_9172_DOL_PIRL_Non-Material-Change.pdf
https://cwdb.ca.gov/wp-content/uploads/sites/43/2025/12/Cal-E-Grants-Participant-Data-Fields-Guide.xlsx
https://cwdb.ca.gov/wp-content/uploads/sites/43/2025/12/Cal-E-Grants-Participant-Data-Fields-Guide.xlsx
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participants, participants are informed of the reason for requesting SSNs in accordance with the 
CWDB’s Privacy Policy and the grantee’s privacy policy.3 
 
Grantees have reported that employer partners and training providers can be sensitive to the 
collection of SSNs and forms that include questions identifying race and/or ethnicity. Participant 
intake forms should include disclaimer language around the collection of SSNs. The CWDB, on 
behalf of the grantees, will work with its state partners to match participant SSNs with 
employment data available from State Unemployment Insurance (UI) and other administrative 
wage records (e.g., Federal and Military employment). This matching procedure is necessary for 
CWDB to collect consistent and reliable aggregate outcome information for each grantee. CWDB 
calculates a set of Workforce Innovation and Opportunity Act Indicators of Performance that 
include entry into employment, employment retention, and median earnings. 
 
Note: A system that allows sensitive information to be stored securely by the grantee needs to 
be in place before such information is collected from participants. Please refer to the Develop 
Policies for Documenting, Validating, and Securing Data section in this document for more 
information and best practices.  
 

Sample Disclaimer Language on the Collection of Personally Identifiable Information 
Grantees may use the following sample text to inform participants how PII is being protected 
and why SSNs are being collected. Underlined text should be tailored appropriately to individual 
projects/programs.  
 
“This project was funded by a grant awarded under the <Grant Program; example: High Road 
Training Partnership>, administered by the California Workforce Development Board (CWDB). 
By state 4 and federal law,5 the CWDB must collect a range of demographic information about 
project participants to track the long-term success of this training program. One piece of 
information collected is the participant’s Social Security Number (SSN). The CWDB asks 
participants to provide SSNs so that employment information can be matched through state 
databases. Although you cannot be denied service for failure to provide your SSN, we strongly 
encourage you to provide it so that the project can measure employment-related outcomes. 
Without this information, we cannot understand how helpful grant programs like this are to 
participants. 
 
Rest assured that we keep your personal information confidential and secure. It will not be 
shared with any outside agencies other than those involved in supporting or overseeing the 
High Road Training Partnership grant received by <Grantee> and issued by the CWDB. Your 

 
3 The CWDB cannot provide legal advice regarding privacy law compliance. Grantees are encouraged to consult 
with legal counsel in developing and maintaining their own privacy policies to comply with all applicable laws in 
collecting, storing, and transmitting participant data. 
4 CWDB is legally mandated to collect participant data in UIC § 14014, UIC § 1095, Executive Order N-16-22, and in 
various other initiative-specific legislation. 
5 29 U.S.C. 3245(d)(1)(A) 

https://cwdb.ca.gov/privacy-policy/
https://codes.findlaw.com/ca/unemployment-insurance-code/uic-sect-14014/
https://codes.findlaw.com/ca/unemployment-insurance-code/uic-sect-1095/
https://www.gov.ca.gov/wp-content/uploads/2022/09/9.13.22-EO-N-16-22-Equity.pdf
https://codes.findlaw.com/us/title-29-labor/29-usc-sect-3245/
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information will never be sold or shared with third-party agencies through your participation in 
grant-supported training activities. Please direct any additional questions concerning the use of 
your personal information to <Name>, <Title> at <Contact Info>.” 
 

Sample Disclaimer Language on the Collection of Sensitive Demographic Information 
Grantees may use the following sample text to inform participants why their sensitive 
demographic information is being collected and their option to opt out of providing such 
information.  
 
“As required by state6 and federal law,7 the CWDB collects sensitive demographic information 
relating to gender identity, sexual orientation, and public benefit recipiency for the purposes of 
statistical analysis and reporting to the Labor and Workforce Development Agency (LWDA). 
Reporting this information helps the CWDB and LWDA gain a better understanding of the 
communities our funding serves. It allows the CWDB to measure the outcomes of various grant 
programs, which in turn informs future workforce development funding.  
 
We maintain demographics confidential and never share identifiable information with outside 
agencies. Providing this information aids CWDB grantees to continuously improve service 
delivery for current and future participants. However, participants have the right not to disclose 
information related to gender identity, sexual orientation, and public benefit recipiency, free of 
penalty. There are no risks in providing demographic information, and participants do not 
directly benefit from reporting their demographic information. If you have questions, concerns, 
or complaints, or think the research has hurt you, email the CWDB research team at 
ResearchUnit@cwdb.ca.gov.” 
 

Understand the Timing of When Information Should be Collected 
Thinking through the best times in a participant’s journey through the training program to 
collect all the required information is an important step in ensuring all the required data 
elements can be reported and no key information slips through the cracks.  
 
Some of the information may be collected at key points before an opportunity is lost or difficult 
to come by again. Other information may be collected from participants at multiple points 
during program participation; however, it may be easier and lead to better results when 
collecting it at some points over others. Not collecting data at the right time or at all can lead to 
missing out on collecting other information later. Below is a table of suggested points in time to 
collect information from participants for each category.  
 

 
6 CWDB is legally mandated to collect participant data in UIC § 14014, UIC § 1095, Executive Order N-16-22, and in 
various other initiative-specific legislation. 
7 29 U.S.C. 3245(d)(1)(A) 

mailto:ResearchUnit@cwdb.ca.gov
https://codes.findlaw.com/ca/unemployment-insurance-code/uic-sect-14014/
https://codes.findlaw.com/ca/unemployment-insurance-code/uic-sect-1095/
https://www.gov.ca.gov/wp-content/uploads/2022/09/9.13.22-EO-N-16-22-Equity.pdf
https://codes.findlaw.com/us/title-29-labor/29-usc-sect-3245/
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Required Information Suggested Point of Collection 

Participant Information (Name, SSN, Eligibility 
Demographics) 

• Eligibility determination 
• Intake 

Training, Career, and Supportive Services • Orientation 
• Service start date 
• Ongoing 

Credentials • Date credential received 

Outcomes • Exit or follow-up surveys post-
completion or post-exit 

 
Participant data is not required to be collected in this specific order, although it may make sense 
depending on service delivery. For example, in certain instances, some participant demographic 
information could be collected at a later stage if necessary. Please refer to the Request for 
Applications (RFA) for the appropriate grant program for more specific information on 
participant eligibility before starting the intake process, as well as the reporting requirements 
for the designated data collection system being used in order to develop an approach that 
works best for your organization and complies with the conditions in the grant agreement.  
 

Develop an Internal Case Management System 
It is essential to maintain case files for each participant using an internal system. To track 
participant progress over time, grantees should have an internal case management system that 
staff can use to record participant data for the program in one place with the ability to make 
changes to reflect new information throughout the grant life cycle. While Cal-E-Grants does not 
yet function as a case management system, some grantees use CalJOBS for case management 
and transfer participant data into Cal-E-Grants monthly. If CalJOBS is the preferred case 
management platform for your organization, a local grant code can be created in CalJOBS for 
state-funded programs.  

 
Using the Local Grant Code consists of two steps:  

1. Activating the local grant under the WIOA application, and  
2. Adding the local grant under the related activity.  
 

Steps To Activate the Local Grant Under the WIOA Application 
1. Access the participant’s WIOA Title 1 application wizard to get started and go to the 

Eligibility Summary section.  
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2. Scroll down to the Non-WIOA Grants area, and under Local Funded Grants, select Yes. 

 

 
 
Note: If adding a state-funded grant program, select Yes next to Non-WIOA Special Grants. 
 

Steps to Add the Local Grant Under the Related Activity  
A list of all available local grants will appear. Find the local grant code and select Add under the 
Action column. Select Finish at the bottom of the page to save the update to the application. 
Now, an activity can be created for the participant using the activated l local grant code.  
 

1. Select Create Activity/Service/Enrollment under the Activity/Service/Enrollment 
section of the WIOA application. (On a newly created WIOA application, select Create 
Participation to create an enrollment and a first activity.): 

Figure 3: List of Available Grant Codes 
 

Figure 1:  Eligibility Summary section 

Figure 2: Non-WIOA Grants section of Eligibility Summary 
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Figure 3: Expanded Activities/Enrollments/Services section 

2. Under Customer Program Group, select 98 – Local Funded Grant. 

 
Figure 4: Customer Program Group field 

3. In the Enrollment Information section, select the grant activated under the WIOA 
application in the Grant field. 
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Figure 5: Enrollment Information section 

4. Create the rest of the activity. Once the activity has been created, the participant will 
have an open activity with the Funding/Grant displaying the locally funded grant that 
was selected. 

 
Figure 6: Funding/Grant column indicating Local Funded Grant 

An existing case management system may be sufficient, but grantees should ensure they have 
reliable and secure methods for tracking all data elements on intake and throughout the period 
a participant is receiving grant-funded services. 
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HOT TIPS  
• Make sure the system includes EVERY required data element as a data field entry for 

each participant record.  
• Make sure the system records all the data elements entered into CalJOBS or Cal-E-

Grants.  
• A participant record should have a corresponding code value for most data elements. In 

some cases, leaving the data field blank is an option if the data element does not apply 
to the participant.  

• Develop a process that partners can follow to help ensure they are collecting 
information in the same way. Provide the partner with a template and request that this 
format be used to submit participant data to the fiscal agent.  
 

Establish Intake Procedures that Build in Participant Data Collection 
Gathering the information needed to inform the data elements should be integrated into every 
aspect of the onboarding process (including eligibility assessment, intake, and orientation). 
Before recording participant data on an individual, first establish whether an individual is 
eligible for the training program and activities. 
 
For example, when participants are deemed eligible to participate, the birth date collected and 
used to determine if a participant was of age to receive services can be included in the internal 
case management system for future reference if they receive additional services or training. 
 
Best Practice: Tracking this information in an electronic format will give grantees, employer 
partners, training providers, and other stakeholders to track outcomes in a systematic way that 
will help ensure consistency and accuracy. 
 
When an individual is determined to be eligible for specific program activities, grantees will 
need to establish an intake process to assess and collect information from that individual. An 
intake process could entail processes like: 

• Completing intake forms. 
• Conducting an intake interview. 
• Hosting intake sessions and/or other orientation activities. 

 
A program’s participant intake and/or enrollment form(s) should include questions that help 
target all relevant initial data required for performance reporting; this might include the date of 
entry into the program, age of the participant, employment status at the program entry, or 
other relevant information.  
 
Often, definitions for the data elements themselves can be used as questions to develop intake 
and enrollment forms. When the language from data elements is transferred to questions on 
the form, this can ensure that the questions are: 1) being asked in a way that explains the 
purpose, and 2) consistent with how outcomes need to be reported. 
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HOT TIP 
The intake process can also be self-registered electronically. Advantages to self-registration are 
that participants can eliminate steps in the case management process and make securing data 
easier. However, if the software is not user-friendly, participants may end up skipping the 
registration process altogether. 
 
If grantees decide to go the electronic route, ensure that training and support are provided on 
software use. Build in other opportunities upfront to establish a relationship with the 
participant so your group can explain why the information solicited is needed and required by 
law. 
 

Establish a Schedule to Regularly Check-in with Participants 
The intake process is only the beginning. Keeping in touch with participants to gather the 
information needed to report all the required data to CWDB is an ongoing process that will 
continue until the grant ends, and in some cases, after the grant term has ended. The CWDB will 
track employment outcomes using the base wage file if a participant provides their SSN, but if 
not, post-exit employment and wages can be tracked through post-exit surveys from 
participants for two quarters following the end of the grant term.  
 
First, grantees should consider how they will collect the information. Several methods, such as 
phone calls, meetings, or surveys, can be used to collect participant feedback. It is important to 
determine the best method based on the program and capacity. Be willing to pivot to a new 
method if one doesn’t seem to be working. 
 
Second, schedule regular check-ins throughout the program to gather the necessary 
information. Depending on the chosen method or the program length (or other factors), 
grantees may decide to check in weekly, quarterly, monthly, once a semester, or at some other 
interval. Assess the chosen interval to see if it’s working. 
 
Grantees may experience challenges attempting to follow up with participants, but there are 
many ways to minimize those challenges if the stage has been set for collecting the participant 
data when they walk in the door. Setting the expectation with participants from the beginning 
that grantees will be in regular contact with them throughout their training and after they 
complete the program leads to a greater likelihood that grantees will be able to get the 
information needed. 
 
HOT TIPS 
Use these tips and incorporate them into a tracking strategy while participants are enrolled in 
training programs: 

• Send calendar invitations to participants to build in time for them to complete surveys to 
highlight their importance. 

• Bundle the check-ins with additional programmatic education or services to entice 
participation. 
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• Test out different ways of asking for the needed information in surveys to see what gets 
the most helpful responses. 

• Give participants the opportunity to provide multiple phone numbers and/or email 
addresses at intake for follow-up purposes. 

• At every check-in, give participants the opportunity to update their contact information. 
• Make check-ins short. 

 

Establish Methods to Follow-up with Participants Post-Exit 
Following up with participants once they leave the training program is crucial. Meeting the 
reporting requirements for CWDB grant programs includes reporting changes in employment 
for participants who complete training programs. To report this information, grantees will need 
to find ways to gather employment information on these participants even if they are no longer 
in regular contact. 
It may be valuable to re-frame the participant-program relationship and develop a program 
design that incorporates indefinite contact with grant-funded participants. As part of that 
program design, establish a follow-up timeline and inform participants of that timeline during 
the enrollment process. A seamless and powerful way to make this follow-up contact a part of 
the program design is to integrate an incentive policy. An incentive policy helps maintain a 
connection with the participants and can assist grantees in collecting this information. 
 
HOT TIPS 
All the strategies from the “Hot Tips” in the previous section for tracking participants while still 
in training can also be used for following up with participants after the program ends. 
Additionally, try some of these additional strategies: 

• Use incentives to pay for specific tools or aids participants need for their jobs, such as 
exam fees, scrubs, tools, or other job-related fees or equipment. 

• Hire a job developer whose job is to develop and refine strategies to successfully reach 
out to employers and participants to gather this information. 

• Schedule group follow-up activities that offer value to grant participants. 
• Send calendar invites to participants to build in time for them to complete surveys to 

highlight their importance. 
• Conduct qualitative interviews to gather information that participants might not want to 

share on a survey. 
• Use automated texting with simple, leading questions related to the current 

employment status. Ex. Are you still working at [Name of Company] as a [job position]? 
• Establish a Memorandum of Understanding with employer partners to provide 

information on participants about changes in their employment. 
 

Establish a Process for Regularly Collecting Information from Grant Partners 
The method for collecting and tracking participant data will vary depending on the service 
providers of the grant. Although training providers, employers, workforce agencies, or other 
types of service providers may not have access to CalJOBS or Cal-E-Grants directly, it’s important 
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to establish a communication protocol between the Grant Program Manager/Director and those 
collecting data directly from participants. Participant-level data will always need to be collected, 
stored, and transmitted securely. 
 
Note: It is the responsibility of the grantee or a designated grant partner, not the participating 
employer to determine incumbent worker eligibility. Grantees or their designated grant 
partners must establish and document the eligibility of all participants, including incumbent 
worker participants. 
 
HOT TIPS 
Use these tips to help improve the data collection process between program grantees, 
employer partners, and education and training providers: 

• Develop an electronic case management system that can be transferred between 
appropriate program partners to better assist the development and submission of 
monthly and semi-annual reports to CWDB. 

• Ensure all data elements are reviewed, and definitions are understood by all partners 
before deciding how to answer the data element code values for a participant. 

• Ensure that all relevant program partners and training participants understand why 
certain information is collected, where it is sent, and for what purpose. 

o Example: Training participants are often given a paper form to fill out basic 
details, which is handed back to the training provider with minimal face-to-face 
interaction. Unless there is an intermediary, like a case manager, the need for this 
information may not be fully explained or understood. 

• Add notice, disclaimer language, and guidance during the enrollment process so 
participants will understand why certain information is being collected. 

• Ensure relevant dates that inform certain data elements are recorded. 
 

Develop Policies for Documenting, Validating, and Securing Data 
Documenting and Validating Data 
Although the CWDB does not collect documentation to validate participant data, grantees 
should maintain records to verify the data they report on participants in case an audit is 
conducted. Audits or monitoring are typically conducted by outside state agencies, such as the 
Employment Development Department (EDD) Compliance Review Office (CRO), not the CWDB. 
Recipients of WIOA-funded programs must retain records for a period of three (3) years from 
the date of their last expenditure report submitted to the EDD Central Office Workforce Services 
Division. Please refer to the appropriate Source Documentation List provided by the CWDB to 
ensure that the correct documentation is collected for state-funded and/or WIOA grant 
programs.  
 
Documentation for state-funded programs is not required to be submitted to the CWDB but 
should be collected and stored securely for three years in the event of an audit. Documentation 
must be uploaded to CalJOBS for WIOA-funded grant programs. 
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Grantees should also review aggregated reports available on either CalJOBS or Cal-E-Grants 
each quarter for accuracy and to ensure CWDB’s official data matches the partner’s records and 
correct and update the data file as needed. Data change requests can be initiated by emailing 
the Research Unit directly. 

Securing Personally Identifiable Information  
Grantees may possess large quantities of Personally Identifiable Information (PII) for program 
participants. This information is generally found in personnel files, participant data sets, 
performance reports, program evaluations, grant and contract files, and other sources. Grantees 
are required to protect PII when transmitting information, but are also required to protect PII 
and sensitive information when collecting, storing, and/or disposing of it. The easiest way to 
securely store this information electronically is through encryption, which protects the data 
from unauthorized access. Once encrypted, it can also be sent via an encrypted email, which 
requires a password to open.  
 
If any email contains PII either in its body or attachments, an easy way to add a layer of 
protection is to use email encryption. The following instructions outline how to use email 
encryption within Outlook and Gmail at the time this guide was created. 

Encrypting emails containing PII (Outlook) 
Take the following steps to encrypt a single email message: 

1. In the message being composed, select File > Properties. 
2. Select Security Settings, then select the check box for Encrypt message contents and 

attachments. 
3. Compose the message and Send. 

 
Take the following steps to encrypt all outgoing messages: 
When encrypting all outgoing messages by default, messages can be written and sent the same 
way as any other message. Still, all potential recipients must have a digital ID to decode or view 
the messages. 
 
Take the following steps to encrypt all outgoing messages: 

1. On the File tab, choose Options >Trust Center > Trust Center Settings. 
2. On the Email Security tab, under Encrypted email, select the check box for Encrypt 

contents and attachments for outgoing messages. 
 

Note: To change additional settings, such as choosing a specific certificate, select Settings. 
 

Encrypting emails containing PII (Gmail): 
Take the following steps to send a confidential message in Gmail via a web browser: 

1. Log in to your Gmail account. 
2. Select Compose. 

mailto:ResearchUnit@cwdb.ca.gov
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Figure 8: Confidentia l Mode toggle 

3. Select the Confidential Mode toggle in the bottom right of the window. 
4. Set an expiration date and passcode. 
5. Select Save. 

 
Tip: Utilizing an electronic case management system that allows grantees to upload and store all 
documents can help maintain security and reduce the need for paper file storage. Platforms 
such as Box, Dropbox, SharePoint, and Google Drive offer secure file storage while facilitating 
document sharing for registered users. Please note that if using Google Drive, files must not be 
synced with email addresses outside of the address that has been granted access to maintain 
security.  
 

Password Protecting Excel Files: 
Excel files containing PII can be secured with password protection, making them safer to share 
with partners. When using password protection to store an Excel file securely, ensure the 
password is complex and uses special characters, uppercase and lowercase letters, and 
numbers. At the time this document was created, the following steps outline how to protect the 
Excel file with a password to prevent others from accessing data in the file.  

1. Select File > Info. 
2. Select the Protect Workbook box and choose Encrypt with Password. 
3. Enter a password in the Password field, and then select OK. 
4. Confirm the password in the Reenter Password box, and then select OK. 

 

Understand Technical Assistance Resources 
The Research Unit at CWDB is available for technical assistance in reporting participant data and 
issues related to the CEG platform. The Research team can be contacted directly by emailing 
ResearchUnit@cwdb.ca.gov. Additional guidance and resources related to participant data and 
reporting are available on the Grantee Guidance webpage.  
 

mailto:ResearchUnit@cwdb.ca.gov
https://cwdb.ca.gov/cwdb-home/grant-information/grantee-guidance/
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For grant administration or invoicing assistance, contact the appropriate Program Analyst or 
team for the specific grant. If grantees are unsure who the assigned Program Analyst is, contact 
the general inbox for the grant program or the Research Unit.  
 
For any other general assistance needed, please contact the contracted Technical Assistance 
(TA) provider for the grant program. If grantees are unsure who the contracted TA is for their 
grant program, they can contact the appropriate Program Analyst for more information. 
  

mailto:ReserachUnit@cwdb.ca.gov
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Appendix 
1. Participant Individual Record Layout (PIRL)—CalJOBS  
2. Data Fields Guide—Cal E-Grants WIOA Source DocumentationCEG Source 

Documentation 

https://www.dol.gov/sites/dolgov/files/ETA/Performance/pdfs/ETA_9172_DOL_PIRL_Non-Material-Change.pdf
https://cwdb.ca.gov/wp-content/uploads/sites/43/2025/12/Cal-E-Grants-Participant-Data-Fields-Guide.xlsx
https://cwdb.ca.gov/wp-content/uploads/sites/43/2024/05/24_5_8_Source-documentation-List_CalJOBS_FINAL_ACCESSIBLE.pdf
https://cwdb.ca.gov/wp-content/uploads/sites/43/2025/12/25_5_23_Source-Documentation-List-CEG_FINAL.pdf
https://cwdb.ca.gov/wp-content/uploads/sites/43/2025/12/25_5_23_Source-Documentation-List-CEG_FINAL.pdf
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